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1 Biacore T200 Getting Started

Introduction
This Getting Started handbook is designed as a self-study guide to introduce you to the
basic operations of Biacore™ T200, Biacore T200 Control Software and Biacore T200
Evaluation Software.

The handbook, together with the associated reagent kit, will take you through the basic
steps in a Biacore experiment. The Chapter 2 Background information, on page 6 of
this handbook will provide important information that will help you carry out the exer-
cises described in the later sections. There you will also find useful information
regarding basic assay development.

The reagents in the Getting Started Kit are for training purposes only and are supplied
in quantities allowing for two repeated exercise sessions, following the instructions in
this handbook. Biacore AB can accept no responsibility for results obtained with these
reagents in any other context.

The reagents should be stored at between +4°C to +8°C and should be used within one
week of opening.

Requirements
The following are required for completing the Getting Started exercises:

• Time: approximately one day

• Biacore T200 instrument with Reagent Rack 2 and Sample and Reagent Rack

• Familiarity with PC and Windows

• Getting Started Kit

• Series S Sensor Chip CM5 (not included within the Getting Started Kit)

• Amine Coupling Kit (not included within the Getting Started Kit)

• Micropipettes; 2 to 10 μl, 10 to 100 μl and 100 to 1000 μl and tips

References
For further details on the topics discussed in this booklet, refer to:

• Biacore T200 Instrument Handbook

• Biacore T200 Software Handbook

• Biacore Advisor Tutorial (CD-ROM)

• Sensor Surface Handbook
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Contents of the Getting Started Kit
The contents of the Getting Started Kit are listed in Table 1.1, on page 4. All solutions,
except for the 10× HBS-EP+ buffer, ligand, analyte and enhancement molecule are
ready for use. The 10× HBS-EP+ buffer, ligand, analyte and enhancement molecule
should be diluted as described in the exercises and used immediately after dilution.

Table 1.1: Contents of the Getting Started Kit. For in vitro use only. Storage: +4°C to +8°C for all

solutions.

Reagent/Item, quantity Specification

10× Running buffer (50 ml) 10× HBS-EP+ buffer; 0.1 M HEPES pH 7.4, 1.5 M
NaCl, 30 mM EDTA, 0.5 (v/v) Surfactant P20

Ligand (50 μl) Monoclonal mouse-anti-human β2-microglo-
bulin

Analyte (50 μl) Human β2-microglobulin

Enhancement molecule (50 μl) Polyclonal rabbit-anti-human β2- microglo-
bulin

Immobilization buffer (1 ml), 2
pcs

10 mM sodium acetate, pH 5.0

Regeneration solution (1 ml), 2
pcs

10 mM glycine-HCl, pH 2.5

BIAnormalizing solution 70%
(1.5 ml)

70% (w/w) glycerol

(for Biacore T200, Biacore T100, Biacore 3000
and Biacore X)

Plastic vials, 40 pcs 0.8 ml polypropylene microvials, diam. 7 mm.

Caps for 7 mm plastic vials, 40
pcs

Ventilated kraton G (SEBS) rubber caps, diam. 7
mm.

Plastic screw top vials and caps,
6 pcs of each

2.0 ml polypropylene screw top vials, diam. 10.8
mm and non-penetrable screw caps with o-ring
seal

Ordering information
Ordering information is given in Table 1.2. For further information, please visit 
cytiva.com/biacore or contact your local Biacore system representative.

Table 1.2: Ordering information.

Item Code No.

10× HBS-EP+ buffer (1000 ml) BR-1006-69

Series S Sensor Chip CM5 (package of 3 chips) BR-1006-68

Amine Coupling Kit BR-1000-50

BIAmaintenance Kit BR-1006-51
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Item Code No.

Biacore T200 Instrument Handbook 28976863

Biacore T200 Software Handbook 28976878

Biacore Advisor Tutorial, CD-ROM BR-1005-44

Sensor Surface Handbook BR-1005-71

Plastic vials, 7 mm (package of 1000 vials) BR-1002-12

Plastic screw top vials and caps 10.8 mm (package of 1000 vials and
1000 caps)

BR-1002-14

Caps for 7 mm vials (package of 600 caps) BR-1005-02
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2 Background information

This chapter is intended to provide the basis for a more detailed understanding of the
main steps in a Biacore assay. The information goes beyond what is explicitly covered
in the exercises and is, therefore, a complement to the exercises.

In this chapter

Section See page

2.1 Biacore terminology 7

2.2 Sensor surface properties 8

2.3 Immobilization 9

2.4 Interaction analysis 14

2.5 Regeneration 16

2 Background information
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2.1 Biacore terminology
• When molecular interactions are studied in Biacore, one of the interactants is

immobilized on the sensor surface while the other is passed over that surface in
solution. In Biacore terminology, ligand refers to the immobilized component and
the interactant present in the sample injected over the surface is referred to as the
analyte (Figure 2.1).

Figure 2.1: “Ligand” refers to the immobilized interactant and “analyte” refers to the
other interactant present in the sample injected over the sensor surface.

• The response is measured in resonance units (RU) and is proportional to the
molecular mass on the surface. For an interactant of a given mass, therefore, the
response is proportional to the number of molecules at the surface.

• A sensorgram is a plot of response against time, showing the progress of the inter-
action. The sensorgram is displayed on the computer screen during the course of an
analysis.

There are three major steps in a Biacore assay. These are:

1. Immobilization: The process by which the ligand is attached to the sensor chip
surface.

2. Interaction analysis: The analyte is injected over the sensor chip surface and the
interaction between the analyte and the immobilized ligand is monitored.

3. Regeneration: The process of removing bound analyte from the ligand on the
surface.

2 Background information
2.1 Biacore terminology
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2.2 Sensor surface properties
Series S Sensor Chip CM5, which is used in the Getting Started Kit, is a glass slide
coated with a thin layer of gold, to which a matrix of carboxymethylated dextran is
covalently attached (Figure 2.2). The gold is required for generation of the surface
plasmon resonance (SPR) response. The dextran matrix allows covalent immobilization
of biomolecules using well-characterized chemistry and provides a hydrophilic envi-
ronment suitable for a wide variety of protein interactions.

Figure 2.2: Schematic illustration of the structure of the surface of the Sensor Chip CM5.

In addition to Series S Sensor Chip CM5, which is the most versatile chip, Cytiva offers a
range of sensor chips with different properties that allow immobilization of biomole-
cules with different characteristics. Refer to cytiva.com/biacore for further information.

2 Background information
2.2 Sensor surface properties
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2.3 Immobilization
There are different ways of immobilizing substances to the sensor surface. The choice
of immobilization method depends on the properties of the substance. The immobili-
zation approaches may be directed towards amine, carboxyl, thiol or hydroxyl groups
on the ligand, or may use specific tags introduced into the ligand.

Amine coupling
Amine coupling chemistry is the most widely applicable approach for covalently
attaching biomolecules to the sensor chip surface and is suitable for the ligand
included in the Getting Started Kit. With this method, the dextran matrix on the sensor
chip surface is first activated with a mixture of 1-ethyl-3- (3- dimethylaminopropyl)
carbodiimide (EDC) and N-hydroxysuccinimide (NHS) to give reactive succinimide
esters. Ligand is then passed over the surface and the esters react spontaneously with
amino groups or other nucleophilic groups to link the ligand covalently to the dextran
(Figure 2.3). After the injection of ligand, ethanolamine is passed over the sensor
surface to deactivate remaining active esters.

Figure 2.3: Amine coupling of ligands to the sensor chip surface.

Conditions for immobilization
At the concentrations of ligand commonly used for immobilization (20 to 200 μg/ml),
the expected levels of immobilized ligand would be low in the absence of a mechanism
that attract the ligand molecules to the sensor surface. The main mechanism for this
concentration process is electrostatic attraction of the ligand to the surface. This
attraction is referred to as pre-concentration and can result in a several thousand-
fold concentration of ligand on the surface.

The carboxymethylated dextran matrix of the sensor chip carries a net negative charge
at pH values above about 3.5. The pH of the immobilization buffer should, therefore, be
higher than 3.5 and lower than the isoelectric point of the ligand in order to achieve
efficient pre-concentration. For many proteins, coupling in 10 mM sodium acetate
buffer (pH 4.5) works well, although the choice of pH can be a critical parameter in
determining the success of immobilization in some cases. If you have to use other
conditions, bear the following considerations in mind:

• The ionic strength should be low (10 mM monovalent cations recommended) for the
electrostatic attraction to occur.

2 Background information
2.3 Immobilization
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• Buffer components containing primary amine groups and other strong nucleophilic
groups (e.g. Tris or sodium azide) must be avoided for amine coupling, as these will
compete with the ligand for active esters on the sensor chip surface.

Many proteins show limited stability in low ionic strength solutions and at low pH. The
ligand solutions should, therefore, be prepared directly before use.

Example of immobilization pH-
scouting

The experimental procedure of finding the appropriate immobilization pH is referred to
as pH-scouting. The example below shows how to set up an immobilization pH-
scouting and how to assess the results.

 

Example 1

In this example, the ligand immobilized was the monoclonal anti-β2- microglobulin
antibody included in the Getting Started Kit. The ligand was diluted in sodium acetate
buffers with different pH (pH 5.5, pH 5.0, pH 4.5 and pH 4.0) to a final concentration of
30 μg/ml in each sample. The flow rate was 10 μl/min and the contact time was two
minutes. If your sample availability is restricted and you have to minimize ligand
consumption, the flow rate may be set to 5 μl/min and/or a lower ligand concentration
may be used.

After the last ligand injection, a wash solution was injected to remove any remaining
ligand molecules. A short pulse of 1 M ethanolamine-HCl pH 8.5 (included in the Amine
Coupling Kit) or 50 mM NaOH is commonly used for washing surfaces that have been
used for pre-concentration/pH-scouting experiments.

As shown in Fig. 2.4, on page 11, the attraction of the protein into the dextran matrix
on the sensor chip surface increased with decreasing pH of the buffers. This is
explained by the fact that the protein is less positively charged at pH 5.5 as compared
to pH 4.0, which affects the attraction to the negatively charged dextran matrix. pH 5.5,
5.0 and 4.5 all gave a satisfactory pre-concentration effect. At pH 4.0, the sensorgram
approached a plateau at the end of the injection, which indicates that the maximum
level of attraction was soon to be reached at that pH.

It should be pointed out, however, that pH-scouting does not provide a conclusive
answer regarding suitable immobilization conditions. It is well known that amine
coupling is less efficient at low pH and in order to fully optimize the conditions and verify
the choice of pH, the entire immobilization procedure should be performed.

2 Background information
2.3 Immobilization
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Figure 2.4: Sensorgram showing the SPR responses generated by the ligand anti-β2-
microglobulin injected in immobilization buffer pH 5.5, pH 5.0, pH 4.5, pH 4.0,
respectively. Injection of wash solution after each ligand injection removes any
remaining ligand from the sensor chip surface.

In Fig. 2.5, on page 12, the sensorgrams from amine couplings of monoclonal anti-β2-
microglobulin at pH 5.5, 5.0, 4.5 and 4.0 are shown. Although the preconcentration
response was very high at pH 4.0 (Figure 2.4), the final immobilization level was lower
than at the other pH values tested. This clearly demonstrates the pH-dependence of
the amine coupling chemistry and pH 4.0 was, therefore, excluded in this case.

As mentioned previously, the pre-concentration effects at pH 5.5, 5.0 and 4.5 were all
acceptable (Figure 2.4). Since the immobilization level at pH 5.5 was higher than the
immobilization levels at pH 5.0 and 4.5, pH 5.5 could appear to be the best choice
(Figure 2.5). By looking at the sensorgrams (Figure 2.5), however, it becomes evident
that at pH 5.5 the response after attraction and covalent coupling has not reached the
maximum level. At pH 5.0, the sensorgram begins to flatten out after the covalent
coupling (the maximum level is almost reached), which may contribute to an increase
in the robustness of the assay set-up. At pH 4.5, the plateau is more evident, but at the
same time the immobilization level has dropped. Consequently, in this case pH 5.0
should be chosen for immobilization of monoclonal anti-β2-microglobulin.

2 Background information
2.3 Immobilization
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Figure 2.5: Sensorgrams showing the immobilization of anti-β2-microglobulin via amine
coupling at pH 5.5, pH 5.0, pH 4.5 and pH 4.0, respectively. For further information on
sensorgrams from amine couplings, refer to section Immobilization results .

Immobilization levels
The binding capacity of the surface will depend on the levels of immobilized ligand. The
term maximum response (Rmax) is often used in connection with Biacore experiments
and describes the binding capacity of the surface in terms of the response at satura-
tion. A theoretical Rmax value can be calculated using the formula below:

A theoretically calculated Rmax is often higher than the experimentally derived Rmax for
the same interaction. There are many potential explanations for this, such as that the
ligand is not fully active or that there is steric hindrance of the interaction, for example.

Different applications may require different binding capacities. A low Rmax, for example,
is often beneficial in kinetic analyses, while higher levels are advantageous in concen-
tration measurements.

2 Background information
2.3 Immobilization
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Ligand requirements
The quality and purity of the ligand have an important effect on determining the specif-
icity and analyte binding capacity of the surface. The ligand should be as specific as
possible for the analyte as the selectivity of the assay is determined by specificity. If
necessary, an enhancement molecule can be used to increase the sensitivity and/or
specificity of the assay.

The purity of the ligand is of vital importance for the experimental results. Impurities
may be immobilized on the sensor chip and could affect the analyte binding capacity of
the surface. Sensor surfaces immobilized with impure ligand solutions may give rise to
results that are difficult to interpret. The recommendation is, therefore, to use as pure
ligand solutions as possible.

Cross-reactivity (i.e. binding of analyte-related molecules to the ligand) and nonspe-
cific binding (i.e. general binding to the ligand) are other factors, which can be
controlled through the choice of ligand. Note that these factors are generally appli-
cable to the vast majority of immunoassay formats and are not specific to Biacore
assays.

2 Background information
2.3 Immobilization

Biacore T200 Getting Started 28980883 AC 13



2.4 Interaction analysis
During injection of the analyte, the binding of analyte to ligand takes place and is moni-
tored in real time on the screen. After the analyte injection, when buffer flows over the
surface, the dissociation of the analyte/ligand complex is monitored. Although
analytes in crude sample matrices can be measured and the need for sample purifica-
tion is low, a few guidelines on sample requirements are given below.

Sample requirements
The detection principle in Biacore technology measures changes in refractive index (RI)
that are related to changes in mass close to the sensor surface. The design of the opto-
interface allows for measurements of samples in crude environments, such as serum
and cell culture supernatants.

Sample environments that differ greatly from the running buffer will give rise to a bulk
refractive index (RI) effect that is commonly present during an injection. Bulk refractive
index effects do not affect the binding. Our recommendation is, however, that the
samples should be diluted in running buffer to minimize bulk shifts.

The bulk RI contribution of the sample requires that measurement points (report
points) are set before and immediately after an injection, where running buffer flows
over the surface. The relative response then reflects the amount bound (Figure 2.6).

Bulk
contribution

RU

Time

Bulk
contribution

Binding

Dissociation

Amount
bound

Baseline

Figure 2.6: Contribution of bulk refractive index to the response.

One useful feature of Biacore T200 Control Software is that the bulk contribution can
be automatically subtracted. Flow cell 1 and/or 3 can be used as a reference cell for in-
line reference subtraction, providing direct recording and display of blank-corrected
sensorgrams. The reference curve subtraction automatically corrects for the small
time delay between the serial flow cells. A schematic illustration of the principle of
reference subtraction is shown in Fig. 2.7, on page 15.

2 Background information
2.4 Interaction analysis
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Figure 2.7: The effect of reference subtraction. The sensorgram from the reference
surface shows the contribution of the bulk, whereas the sensorgram from the active
surface shows the actual binding response plus the bulk contribution. In the reference-
subtracted sensorgram, only the binding response is shown.

Although the reference subtracted sensorgram shows the actual binding response, it
is important to inspect the sensorgrams from both the reference and active surfaces.
The sensorgram from the reference surface will, for example, reveal non-specific
binding. Remember that non-specific binding cannot be accurately corrected by
subtraction of the response on a reference surface, since the binding is not necessarily
identical on the active and reference surface. In Section 3.5 Exercise 4. Interaction anal-
ysis, on page 42 and Section 3.6 Exercise 5. Interaction analysis – multiple binding, on
page 53, automatic reference subtraction will be used.

2 Background information
2.4 Interaction analysis
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2.5 Regeneration
Regeneration is the process of removing bound analyte from the ligand on the sensor
chip surface after analysis of a sample.

Efficient regeneration (removing bound analyte without affecting ligand activity) is
crucial to a successful assay. If the regeneration is incomplete or the binding activity of
the surface is reduced, the performance of the assay will be impaired and the useful
lifetime of the sensor chip will be shortened. Time spent on establishing suitable regen-
eration conditions is, therefore, a valuable investment.

The choice of conditions for regeneration is dictated by the stability and nature of the
ligand and analyte. Our experience has shown that while different applications may
need individually tailored regeneration conditions, many surfaces can be regenerated
using brief exposure to acidic (glycine-HCl) or basic (NaOH) solutions.

If the sensor surface is not efficiently regenerated with high or low pH (either because
the analyte is not fully removed or because the ligand loses activity), other conditions
may be tested alone or in combination with high or low pH. These include:

• Up to 100% ethylene glycol

• High ionic strength (e.g. ≤ 5 M NaCl or ≤ 4 M MgCl2)

• Low concentrations of SDS (≤ 0.5%)

Testing regeneration conditions
When exploring appropriate regeneration conditions, it is important to test an interval
of different conditions, such as pH or ion concentrations, for example. Our recommen-
dation is to use mild conditions first and then increase the harshness of the treatment
progressively until suitable conditions are established. In this way, the risk of damaging
the ligand on the sensor surface is minimized.

Exploratory testing for regeneration conditions involves injection of analyte over the
surface, followed by regeneration solution. The extent to which the analyte is removed
is indicated by the response after the injection of regeneration solution. A second
injection of analyte is necessary to test whether the ligand is still active and binds the
same amount of analyte as before the exposure to the regeneration solution Fig. 2.8, on
page 17 .

2 Background information
2.5 Regeneration
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Figure 2.8: Efficient regeneration removes all bound analyte. A second injection of
analyte reveals whether the ligand is still fully active.

Injection of regeneration solution often gives a considerable bulk response because
the refractive index of the regeneration solution is not matched with the running
buffer. The relative bulk response may be either positive or negative depending on the
solution used.

The analyte injections described above may be used when you want to establish
whether a particular regeneration strategy is worth pursuing. To establish regenera-
tion conditions reliably and reveal trends in regeneration efficiency and ligand activity,
it is necessary to perform a series of repeated cycles of analyte injection and regenera-
tion. At least five cycles of analyte binding and regeneration are recommended in
testing new regeneration conditions. This regeneration scouting procedure is
supported in the Regeneration Scouting Wizard in the T200 Control Software. Once the
conditions have been found, more extensive tests may be performed to establish that
the assay is stable through large numbers of repeated cycles.

General guidance on how to interpret the trends in analyte binding response and base-
line response is given below:

• Ideal regeneration: The analyte response is constant after repeated injections
and within ±10% of the level reached in the first injection.

• Too mild conditions: The analyte response decreases and the baseline response
increases. The decrease in analyte response results from incomplete removal of the
analyte from the surface so that the baseline increases. Test one step harsher
conditions or change the type of regeneration solution.

• Too harsh conditions: The analyte response decreases and the baseline response
is constant or decreases. The drop in analyte response without a corresponding
increase in baseline response indicates that the surface is losing analyte-binding
capacity. Change the type of regeneration solution. You may have to prepare a new
surface if the ligand has been too extensively damaged.

2 Background information
2.5 Regeneration
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Choice of regeneration conditions
Example 2

In this example, regeneration solutions with different pH were tested. Each cycle
consisted of an injection of analyte followed by a single injection of regeneration solu-
tion. Each regeneration solution was tested for five identical cycles.

As is shown in Figure 2.9 and Fig. 2.10, on page 19, at pH 3.0 the analyte binding
decreased and the baseline response increased. This suggests that the analyte was not
removed from the surface and the binding site on the ligand remained occupied.
Consequently, more material accumulated on the surface, allowing less analyte to bind
in each cycle. The first condition (pH 3.0) appeared, therefore, to be too mild.

pH 2.5 showed some improvement, but the regeneration was still not good enough,
since several cycles were needed to reach a stable sample response. In addition, the
baseline was still at a higher level than the starting value.

The third condition (pH 2.0) looks good. Both the sample response and the baseline
were close to the starting values after each cycle.

The fourth condition (pH 1.5) was too harsh, since the sample response decreased. The
baseline was, however, still acceptable.

The conclusion from this experiment would be to use pH 2.0 as the regeneration solu-
tion. The next step would be to test that the surface remains active and is not harmed
by this solution during the number of cycles that the assay is intended to cover.

Figure 2.9: Regeneration solutions of different pH were tested to find the best
regeneration condition for the ligand and analyte. The sample response after each
analyte injection (relative to the baseline).

2 Background information
2.5 Regeneration
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Figure 2.10: Regeneration solutions of different pH were tested to find the best
regeneration condition for the ligand and analyte. The baseline level after each
regeneration cycle. The report points from the first cycle give the starting levels (far left
in the diagrams). Thereafter, the points are grouped according to the regeneration
conditions tested.

 

Example 3

This example is similar to the previous one, but shows the regeneration scouting for
the analyte and ligand included in the Getting Started Kit performed with a Biacore
T200 system. To establish appropriate regeneration conditions for the monoclonal
anti-β2-microglobulin (the ligand) and the β2-microglobulin analyte, injections of
analyte followed by regeneration solution were performed repeatedly. Four different
glycine-HCl regeneration solutions (pH 3.0, 2.5, 2.0 and 1.5) were examined using five
repeated injections.

The results can be seen in Fig. 2.9, on page 18 and Figure 2.10. At pH 3.0, the sample
response decreased and the baseline level increased compared to the starting values,
indicating that this regeneration solution was too mild. At pH 2.5 and 2.0, the sample
responses were stable, returning back to the approximate level of the starting value. At
pH 1.5, there was a slight loss of analyte response, indicating that this regeneration
solution was too harsh.

This example illustrates that clear-cut differences in the response to different regener-
ation solutions cannot always be seen. In this case, pH 2.5 was chosen for further
testing, although pH 2.0 seemed to give an equivalent effect.

2 Background information
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Figure 2.11: Glycine-HCl solutions with different pH were tested to establish
appropriate regeneration conditions for the ligand anti-β2-microglobulin and the
analyte β2- microglobulin. The baseline response is indicated on the right-hand axis
and the sample response on the left-hand axis.

2 Background information
2.5 Regeneration
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3.1 Description of the experimental set-up
The experiments described in this handbook exploit the binding of β2- microglobulin to
immobilized monoclonal anti-β2-microglobulin antibodies. The following steps are
described:

• Start up of the system.

• The pre-concentration effect: Illustration of the importance of the ion strength and
pH of the buffer used for immobilization.

• Immobilization of monoclonal anti-β2-microglobulin via amine coupling.

• Interaction analysis: Injection of two different concentrations of β2- microglobulin
and evaluation of the results.

• Multiple binding: Injection of an enhancement molecule to amplify the signal from a
low concentration of analyte.

• Maintenance routines.

Upon completion of the Getting Started experiments, you should have a basic under-
standing of the main steps in a Biacore assay and how to handle the instrument and
the software. You should also be ready for incorporation of your own reagents into
similar protocols.

3 Exercises
3.1 Description of the experimental set-up
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3.2 Exercise 1. Start up
This section deals with starting up the system, setting up the liquids required for the
run, docking the sensor chip, flushing the liquid system and normalizing the signal
response. The priming procedure flushes the liquid system with running buffer. This
should be done when a new sensor chip is inserted and/or the running buffer is
changed.

Start the system

Step Action

1 Switch on the Biacore T200 instrument, PC and printer. If the instrument has
been switched off, temperature stabilization of the detection unit will take
approximately one hour. Wait until the yellow Temperature lamp on the
front panel of the instrument lights steadily.

2 Take out the Getting Started Kit from the refrigerator and equilibrate to
room temperature. Dilute the 10× running buffer with ultrapure deionized
water (0.22μm filtered): Mix 25 ml of 10× running buffer with 225 ml water in
a 250 ml bottle.

3 Start Biacore T200 Control Software: click on the Start menu and select
Biacore T200 Control Software from the Biacore menu. The software
establishes connection with the instrument, which takes about 30 seconds.

Insert a sensor chip and prime with
buffer

Step Action

1 Place the bottle containing running buffer (prepared in Start the system, on
page 23) on the buffer tray (on the left hand side of the instrument, see Fig.
3.1, on page 24). Insert the tube marked A through the septum in the cap,
into the bottom of the bottle. Place unused buffer tubing (B, C and D) in the
holder inside the pump compartment door on the left hand side of the
instrument.

2 Place a 2-liter bottle for waste solution on the waste and water tray on the
right hand side of the instrument. Fit the cap carrying the waste tubes on to
the bottle.

Note:
Do not use a smaller bottle for waste.

3 Exercises
3.2 Exercise 1. Start up
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Step Action

3 Fill a 500 ml bottle with ultrapure water. Fit a cap with septum on to the
bottle and place it on the waste and water tray. Insert the tube for water into
the bottle.

Bu�er tray

Waste bottle

Water bottle

Figure 3.1: Biacore T200.

4 If the instrument already has a sensor chip docked, you are asked to remove
it (see Removing a sensor chip, on page 26 for instructions). If the Sensor
Chip lamp lights steadily (and the instrument has not been switched off), a
sensor chip is already inserted or docked. Remove this sensor chip
(Removing a sensor chip, on page 26) and then insert a new sensor chip
(steps 6-8).

3 Exercises
3.2 Exercise 1. Start up
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Step Action

5 If there is not a sensor chip in the instrument, the sensor chip port opens and
the Insert Chip dialog box appears. Select Chip Type: CM5 from the drop-
down menu. Insert the new sensor chip (see steps 6-8).

6 Insert the sensor chip into the sensor chip port, with the arrow pointing
towards the instrument.

3 Exercises
3.2 Exercise 1. Start up
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Step Action

7 Make sure that the sensor chip is properly inserted. Close the sensor chip
port by gently pressing until it clicks into position.

8 Click on Dock Chip in the Insert Chip dialog box. A standby flow of running
buffer is started automatically when the chip has been docked.

9 Choose Tools →Prime to ensure that all parts of the liquid handling system
are flushed with fresh running buffer. Follow the instructions in the dialog
boxes and start the procedure. When the procedure is finished (after about 7
minutes), click on Close. A continuous standby flow of running buffer is
started automatically when the procedure is finished.

Removing a sensor chip

Step Action

1 If a sensor chip is docked (and the instrument has not been switched off), a
Running Standby is visible in the status window at the bottom of the
screen. Choose Tools →Stop Standby to stop the continuous buffer flow.
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Step Action

2 Choose Tools →Eject Chip or click on the Eject icon. Click on Eject Chip in
the dialog box that appears. This will empty the flow cells, undock and eject
the sensor chip. A countdown timer in the dialog box shows the remaining
time of the undocking procedure.

Rack trays and racks
Three different racks can be used in Biacore T200: Reagent Rack 1, Reagent Rack 2
(Figure 3.2) and Sample and Reagent Rack (Figure 3.3). Reagent Rack 1 and 2 have to be
placed on a removable rack tray that carries one of the reagent racks and/or a micro-
plate. The Sample and reagent rack is mounted directly on a rack tray.

Figure 3.2: Reagent Racks 1 and 2.

Figure 3.3: Sample and Reagent Rack.
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Ejecting and removing the rack tray
or Sample and Reagent Rack

The rack tray can be ejected in three situations: before a run, during the setup of a
wizard run, and during a manual run.

Step Action

1 Eject the rack tray by choosing Tools →Eject Rack. Remove the rack tray
and click on OK to close the port.

Normalizing the signal response

Step Action

1 It is recommended to run the normalize procedure to calibrate the detector
unit when a new chip has been docked and maximum sensitivity is required.
Choose Tools →More Tools. Select Normalize in the Maintenance Tools
folder and click on Start.
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Step Action

2 Click on Next in the subsequent dialog box.

3 Fill a 7 mm vial with at least 120 μl BIAnormalizing solution 70%. If you did
not eject the rack tray in step 15, the rack tray may be ejected from the
wizard window by clicking on Eject Rack. Place the vial containing normal-
izing solution in rack position R2F6. Make sure that the reagent rack cover is
completely closed. Insert the rack tray so that it snaps into position and click
on OK.

4 Click on Start to begin the normalizing procedure. Click on Close when the
procedure has finished (after approximately 8 minutes).
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3.3 Exercise 2. Effect of buffer on pre-concentration
In this exercise, the importance of using a buffer with appropriate pH and ionic
strength to obtain sufficient pre-concentration is demonstrated. The injections are
performed by using the manual injection mode of the instrument. The data collection is
started and the injection commands are entered manually. Manual operation is
convenient during method development when the result of one injection may guide
the next experiment. It can also be used in control experiments, such as injection of
sample over an unmodified sensor chip surface.

Step Action

1 Make sure that no liquid is condensed in the ligand tube as this may affect
the ligand concentration. If needed, spin the tube before diluting the ligand.

2 Make dilutions of the ligand in both HBS-EP+ (running buffer) and immobili-
zation buffer (10 mM sodium acetate, pH 5.0). Use 7 mm plastic vials and cap
all vials. In separate vials, mix 3 μl ligand stock solution with 97 μl HBS-EP+
and 3 μl ligand with 97 μl sodium acetate buffer. Prepare a vial containing
500 μl 10 mM glycine-HCl, pH 2.5 (for regeneration). This vial will also be used
in exercises 4 and 5.

3 Choose Run →Manual Run.
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Step Action

4 Enter Flow rate: 10 μl/min and choose detection in flow cell 4 by ticking
Flow path 4 in the Manual Run dialog box. Click on Eject rack. Place the
ligand diluted in acetate buffer in rack position R2B1, the ligand diluted in
HBS-EP+ buffer in rack position R2C1 and the vial containing glycine-HCl in
rack position R2E1. Make sure that the reagent rack cover is completely
closed. If the sample compartment has closed before you are ready to insert
the rack tray, click on Eject rack again to eject the rack tray carriage. Insert
the rack tray, click on OK and then click on Start.

5 Create a folder and name it “Tutorial”. Enter a file name for the sensorgram
(“date-Exercise2”) in the Save Results As dialog box and click on Save.
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Step Action

6 Inject 10 μl of each preparation over the non-activated surface:

a. Select Command →Inject or click on the Injection command icon.

b. Enter Vial/Well Position: R2B1 (the ligand in sodium acetate buffer) and
Contact time: 60 s.

c. Click on OK.

d. Repeat a-c for position R2C1 (the ligand in HBS-EP+ buffer). You can
enter several commands in sequence. The commands are queued by the
control software.

7 To inject the wash (regeneration) solution after the last sample injection
select Command: Regeneration, enter Position: R2E1 and Contact time: 30 s.
Click on OK.

8 In the Command Queue window, the commands that are put in sequence
are listed. The command sequence can be altered in different ways by right-
clicking on a pending command.

9 Select Commands →End Run to stop the data collection. Click on OK.
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Step Action

10 Compare your sensorgram with Figure 3.4. The difference in electrostatic
attraction between the two different buffers should be obvious. It is possible
to zoom in on any area of the sensorgram by using the left mouse button.
Double-click anywhere in the sensorgram window to zoom out.

Figure 3.4: The sensorgram shows that the electrostatic
attraction of the ligand to the dextran matrix is heavily
dependent on the pH and the ionic strength of the buffer.

11 Pre-defined report points are set by the control software during the run.
These are shown as crosses in the sensorgram together with report point
labels and are listed in the Report Point Table below the sensorgram.
Markers along the x-axis of the sensorgram indicate different events. Report
points, event markers and labels may be hidden by choosing View
→Sensorgram Markers and unchecking the desired options.

12 To quantify the response level, you first have to define a baseline. Zoom in on
the area just before the injection of ligand diluted in sodium acetate buffer.
Select View →Reference Line to activate the reference line. Drag the refer-
ence line to a point 10 to 20 s before the injection start. Select View: Baseline
to display a baseline. This sets the baseline level to zero. The response level
(0.0 RU) is now displayed in a window at the top left on the screen.

13 Drag the reference line to a time point at the end of the injection. As you
move the reference line along the sensorgram the response level at the
different time points can be read in the window at the top left of the screen.

14 Select View →Baseline to remove the baseline and View →Reference Line
to remove the reference line.

15 Close the sensorgram window.
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Conclusion
This exercise illustrates the importance of the ionic strength and the pH of the buffer
on pre-concentration. Dilution of the ligand in HBS-EP+ results in a small pre-concen-
tration effect, while the dilution in 10 mM sodium acetate buffer, pH 5.0, results in a
much higher pre-concentration. Consequently, the choice of immobilization buffer has
a great impact on the experimental results in this case.
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3.4 Exercise 3. Immobilization
In this exercise, the ligand (monoclonal anti-β2-microglobulin) is immobilized on the
CM5 sensor chip surface. A wizard guides you through the different steps in setting up
an immobilization template. The template can be saved and used to simplify further
immobilizations.

Set up a template for immobilization

Step Action

1 In the Run menu, choose Wizard. Select Immobilization in the Surface
Preparation folder and click on New.
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Step Action

2 In the Immobilization Setup wizard window, select Chip Type: CM5 from
the dropdown menu. Tick the options Immobilize flow cell 4 and Specify
contact time and flow rate. Choose Method: Amine and enter Ligand:
antibeta2micro, Contact time: 420 s and Flow rate: 10 μl/min. Click on
Next.

The option Aim for immobilized level, which will not be used here, gives
you the possibility to specify a certain immobilization level that you want the
software to target. This can be useful for example, when you work with a new
protein and need to try out the appropriate immobilization conditions.
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Step Action

3 In the System Preparations dialog box, uncheck the Prime before run
option. Since the Prime procedure was run in Exercise 1 and the instrument
has not been in standby mode for long, Prime is not necessary here.
Temperature settings should be kept at 25°C. Click on Next.
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Step Action

4 The right hand part of the Rack Positions dialog box shows the minimum
volumes of samples required for the immobilization as well as rack positions
assigned for each vial. The left hand part of the dialog box shows the rack
with used positions marked. If you click on a vial, the corresponding table
entry is highlighted, showing the contents of the vial. You can edit vial posi-
tions by pointing on a vial and dragging it to a new position (do not forget to
move the vial in the reagent rack as well!).
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Step Action

5 Prepare your samples and place them in the Sample and Reagent Rack
according to the Rack Positions table:

a. Dilute the ligand in 10 mM sodium acetate buffer, pH 5.0: mix 6 μl ligand
stock solution with 194 μl sodium acetate buffer. The choice of immobili-
zation buffer is based on the pH-scouting in “Example 1” on page 
Example of immobilization pH-scouting, on page 10. Place the capped
vial in position R1A5 in the Sample and Reagent rack.

b. Place a capped vial containing at least the required minimum volume of
EDC (from the Amine Coupling Kit) in position R1A1. The required
minimum volume can be found in the Rack Positions table.

c. Place a capped vial containing at least the required minimum volume of
NHS (from the Amine Coupling Kit) in position R1A2.

d. Place one empty vial in position R1A3.

e. Place a capped vial containing at least the required minimum volume of
ethanolamine (from the Amine Coupling Kit) in position R1A4.

6 Make sure that your vials are in the correct rack positions in Sample and
reagent rack 1. Close the cover completely.

7 In the wizard window (below the racks), select Menu →Save Wizard
Template As. Create a folder and name it “Tutorial”. Enter a file name for the
wizard template (“date-Immobilization”) and click on Save.

8 Click on Eject Rack. Take out the rack tray and replace it with Sample and
reagent rack 1. Insert the rack so that it snaps into position. Click on OK to
insert the rack.

9 Click on Next in the Rack Positions dialog box. The Prepare Run Protocol
dialog box displays important assay steps that have to be checked before
starting the run. Click on Start to begin the immobilization procedure. Enter
a file name for the results: “date-Exercise3” and click on Save. The immobili-
zation will take approximately 30 minutes.
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Immobilization results

Step Action

1 Move the Immobilization Results dialog box out of the way so that you can
compare the resulting sensorgram you obtain with the sensorgram in Figure
3.5.

Figure 3.5: Immobilization sensorgram.

a) Baseline.

b) EDC/NHS activation of the dextran matrix.

c) Baseline after activation.

d) Attraction and covalent coupling of the ligand to the dextran matrix.

e) Buffer washes away loosely associated ligand. The response level at
this point gives a first indication of the immobilized amount.

f) Deactivation and further washing away of loosely associated ligand.

g) The difference in response between points a and g reflects the amount
immobilized.
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Step Action

2 Look at the Immobilization Results dialog box. There are two response levels
reported, which are calculated from the sensorgram in the following way:

Response bound: Response at (e) – Response at (c)

Response final: Response at (g) – Response at (a)

Response final best represents the amount of ligand covalently bound to
the surface. An immobilized level of more than 8000 RU is satisfactory for
this exercise.

Response bound represents the amount of ligand bound to the surface
after ligand injection. This is used in Aim for immobilized level to assess
the level reached.

3 Calculate the theoretical maximum binding capacity (Rmax) of your surface
using the equation below (for more background information, see page 15).
The molecular weight of β2-microglobulin is 11800 Da and the molecular
weight of the monoclonal anti-β2-microglobulin is 150000 Da. Remember
that the ligand is an antibody when entering the stoichiometric ratio in the
equation. This means that theoretically each antibody can bind two analyte
molecules. Consequently, the stoichiometric ratio is 2.

Your theoretical Rmax value:

4 Close the Immobilization Results dialog box and the sensorgram window.
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3.5 Exercise 4. Interaction analysis
In this exercise, two concentrations of β2-microglobulin are injected over the immobi-
lized anti-β2-microglobulin antibody. An application will be set up with the help of the
Binding Analysis Wizard.

Step Action

1 Choose Run: Wizard. Select Binding Analysis in the Assay folder and click
on New.
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Step Action

2 In the Injection Sequence dialog box, choose Flow path: 4 to 3 and Chip
type: CM5. For the injection sequence, use the default settings Sample: 1
and Regeneration: 1. Click on Next.
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Step Action

3 The options Run conditioning cycles and Run start up cycles provide the
possibility to condition the sensor chip surface if required and to run a
number of start up cycles to allow surface stabilization. These are not neces-
sary in this exercise. Make sure that both options are unchecked and click on
Next.

4 Define the parameters for the different injections in the Injection Parame-
ters dialog box. For the Sample, enter Contact time: 180 s, Flow rate: 10
μl/min and Dissociation time: 0 s. For the Regeneration, enter Solution:
Glycine-HCl pH 2.5, Contact time: 30 s, Flow rate: 10 μl/min and Stabiliza-
tion period: 5 s.
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Step Action

5 Enter sample names in the Samples dialog box according to the following
screen dump. Click on Next.

6 In the System Preparations dialog box, uncheck the Prime before run
option. Temperature settings should be kept at 25°C. Click on Cycle Run
List if you want to see a summary of the cycles that will be run in your experi-
ment. Click on Next to continue.
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Step Action

7 In the Rack Positions dialog box, it is possible to edit the positions of the
vials by selecting a vial position and dragging it to a new position. In this
exercise, the default positions in the microplate have to be changed to posi-
tions that fit the vials included in the kit (7 mm plastic vials). An example of
where to put the vials is provided in the following screen dump:

8 Choose None (instead of 96 Well Microplate) from the drop down menu.

9 Prepare your samples:

a. Dilute the analyte by mixing 10 μl analyte stock solution with 990 μl HBS-
EP+ (running buffer) in a 2 ml plastic vial. This will be referred to as the
high concentration of β2-microglobulin.

b. Pipette 100 μl of the diluted analyte solution to another 2 ml plastic vial
and mix with 900 μl HBS-EP. This will be referred to as the low concentra-
tion of β2-microglobulin. This analyte solution will also be used in Exer-
cise 5.

c. Prepare duplicates (200 μl in each 7 mm plastic tube) of each analyte
concentration. Cap the vials.

d. The 7 mm vial containing glycine-HCl (from Exercise 2) will be used in this
exercise. Check that there is at least the minimum volume of regenera-
tion solution required (see the Rack Positions table on step 7) left in the
vial.
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Step Action

10 Place the vials in the positions in Reagent rack 2 that you determined in step
7. Use the table in the Rack Positions dialog box or print a similar table by
choosing Print Rack Positions from the drop down Menu on the lefthand
side at the bottom of the Rack Positions dialog box. Close the reagent rack
cover. Slide the reagent rack into the holder on the rack tray and check that
it is correctly oriented.

11 Eject the inserted rack by clicking on Eject Rack. Remove the Sample and
reagent rack, and load the rack tray with Reagent rack 2. Click on OK.

12 Save the wizard template by choosing Save Wizard Template As from the
drop down Menu. Open the folder “Tutorial” that you created, enter a file
name “date-Ex4-Interaction” and click on Save.

13 Click on Next in the Rack Positions dialog box to proceed to the Prepare
Run Protocol dialog box. Make sure that everything is correct and click on
Start to begin the analysis.

14 Enter a file name for the results: “date-Exercise4” and click on Save. The
analysis will take approximately 30 minutes. A standby flow will be started
automatically when the run has finished.
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Interaction analysis results

Step Action

1 In this exercise, each cycle contains an analyte injection and a regeneration
injection. Compare the sensorgrams obtained from one of the cycles with
high analyte concentration with the sensorgrams in Figure 3.6 (zoom in on
the sensorgrams). In this particular exercise, the reference subtraction (Fc4-
3) is not crucial, since the analyte was diluted in running buffer, i.e. there is no
significant bulk contribution. By looking at the response from the reference
surface, any non-specific binding can be revealed. Reference subtraction is
discussed in more detail in Section 2.4 Interaction analysis, on page 14. Look
at the different cycles by using the Cycle drop down menu.

Figure 3.6: Sensorgrams from the active and reference
surface during injection of β2- microglobulin (the high
concentration). The reference-subtracted sensorgram is
also shown.
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Step Action

2 Close the sensorgram window.

Evaluation of the results

Step Action

1 Start Biacore T200 Evaluation software: click on the Start menu and select
Biacore T200 Evaluation from the Biacore menu.

2 Choose File →Open, and open your results file from Exercise 4. In the Evalu-
ation Explorer you will see a list of Evaluation items. These are predefined
evaluation items (such as Sensorgram) and different locked quality control
plots (such as Baseline: Sample and Binding to reference). Additional evalua-
tion items will also be listed when a new Sensorgram or Plot is created or
when an analysis is performed.

3 Look at the reference-subtracted sensorgrams by selecting Fc4-3 from the
Curve Name menu in the sensorgram window. Click outside the drop down
menu to apply the choice.
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Step Action

4 Choose Sensorgram Adjustment from the Tools drop down menu in the
top right corner of the sensorgram window.
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Step Action

5 To adjust the sensorgrams to a common baseline, tick the option Report
point for Y-Adjustment and choose “baseline” from the drop down menu.
This report point was automatically set by the control software. Click on OK.
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Step Action

6 Zoom in on the sensorgrams during the association and dissociation phase
by using the left mouse-button. The Zoom Lock may be activated by ticking
the option in the top right corner.

7 Click on the evaluation item Baseline: Sample in the Evaluation Explorer.
This plot shows the report point “baseline” plotted against cycle number and
reveals whether there are any trends or drifts in the baseline level between
the cycles, which is important as a quality control of assay performance.

8 Click on the evaluation item Binding to reference. This plot shows the
report point “stability” against the cycle number and reveals if there is any
binding to the reference (in this case Fc3).

9 Close the plot windows and the sensorgram window. Save your evaluation by
choosing File: Save As. Enter a file name (“date-Ex4Eval”) and click on Save.

Conclusions
This exercise provides a simple illustration of the fact that under given experimental
conditions, the SPR response is related to analyte concentration. In addition, the exer-
cise illustrates the reproducibility of duplicate samples.

3 Exercises
3.5 Exercise 4. Interaction analysis

52  Biacore T200 Getting Started 28980883 AC



3.6 Exercise 5. Interaction analysis – multiple binding
In this exercise, a low concentration of analyte is injected over the reference surface
and the surface with the immobilized ligand. To illustrate the possibility to use
enhancement molecules either to amplify a response or to confirm the identity of the
bound analyte, a polyclonal anti-β-microglobulin is injected after the analyte. The injec-
tions are performed by using the Binding Analysis Wizard.

Step Action

1 Choose Run: Wizard. Select Binding Analysis in the Assay folder and click
on New.
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Step Action

2 In the Injection Sequence dialog box, choose Flow path: 4-3 and Chip
type: CM5. For the injection sequence, enter Sample: 1 and Regeneration:
1 and check the option Enhancement. Click on Next.
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Step Action

3 The options Run conditioning cycles and Run start up cycles provide the
possibility to condition the sensor chip surface if required and to run a
number of start up cycles to allow surface stabilization. These are not neces-
sary in this exercise. Make sure that both options are unchecked and click on
Next.
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Step Action

4 Define the parameters for the different injections in the Injection Parame-
ters dialog box. For the Sample, enter Contact time: 180 s, Flow rate: 10
μl/min and Dissociation time: 0 s. For the Enhancement injection, enter
Solution: poly anti-beta2micro, Contact time: 180 s, Flow rate: 10 μl/min.
For the Regeneration, enter Solution: Glycine-HCl pH 2.5, Contact time: 30
s, Flow rate: 10 μl/min and Stabilization period: 5 s. Click on Next.

5 Enter the sample name “beta2micro-low” in the Samples dialog box. Click
on Next.
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Step Action

6 In the System Preparations dialog box, uncheck the Prime before run
option. Temperature settings should be kept at 25°C. Click on Cycle Run
List if you want to see a summary of the cycles that will be run in your experi-
ment. Click on Next to continue.

7 In the Rack Positions dialog box, change the positions so that they fit the 7
mm vials and choose None (instead of 96 Well Microplate) from the drop
down menu. An example is shown in the following screen dump.

8 Eject the rack tray by clicking on Eject Rack.
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Step Action

9 Prepare your samples:

a. Dilute the polyclonal anti-β2-microglobulin by mixing 10 μl antibody
stock solution with 990 μl HBS-EP+ (running buffer) in a 2 ml plastic tube.
Transfer 100 μl of the diluted antibody to a 7 mm plastic vial and cap it.
Place the vial in rack position R2B1.

b. Pipette 100 μl of the “low-concentration” analyte solution from Exercise
4 to a 7 mm plastic vial. Cap the vial and place it in rack position R2C1.

c. The 7 mm vial containing regeneration solution (glycine-HCl, from Exer-
cise 2 and 4) will be used in this exercise. Make sure that the vial is placed
in rack position R2E1.

10 Load the rack tray into the instrument and click on OK.

11 Click on Next in the Rack Positions dialog box and proceed to the Prepare
Run Protocol dialog box. Make sure that everything is correct and click on
Start to begin the analysis.

12 In the Save Wizard Template As dialog box, open the folder “Tutorial”,
enter a file name for the wizard template (“date-Exercise5”) and click on
Save.

13 Enter a file name for the results (“date-Exercise5”) in the Save Results As
dialog box and click on Save.
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Multiple binding results

Step Action

1 Compare the resulting sensorgram from Fc4 with that shown in Figure 3.7.

Figure 3.7: The sensorgram clearly shows the enhancing
effect of the injection of polyclonal anti-β2-microglobulin
(the enhancement molecule) as compared to the response
generated by the injection of the low concentration of
analyte.

2 Select the sensorgram in Fc4 by using the Curve drop down menu or clicking
on the sensorgram. Select View: Reference Line to activate a reference
line. Drag the reference line to a time point somewhere during the first half
of the analyte injection in the sensorgram.

3 Add a report point by selecting Edit: Add Report Point. Enter the name
“Binding_Early_beta2micro” in the Id field. The response recorded for the
report point will be averaged over the time window specified by the Window
parameter (use the default value of 5 s). Enter the time at which the report
point should be placed (displayed in the Reference line window on the top
left of the screen). The baseline option can be checked in order to use the
added report point as a baseline for relative responses in other report points.
The option Apply to all curves places the report points at the same posi-
tion on all curves. Click on OK.

4 Drag the reference line to a position just after the injection of the polyclonal
anti-β2-microglobulin. Add a report point called “Binding_Early_Polyanti-
beta2” by following the instructions in step 3.

5 The report points are now listed in the results table below the sensorgram.
Report points can also be added/edited in Biacore T200 Evaluation Software.

6 Remove the reference line by choosing View: Reference Line.
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Step Action

7 Look at the sensorgram from Fc3 (the reference cell) to determine whether
there is any non-specific binding to the dextran matrix.

8 Close the sensorgram window.

Conclusions
In this exercise, the effect of an enhancement molecule is clearly seen. Enhancement
molecules can be used in situations other than the signal amplification illustrated in 
Section 3.6 Exercise 5. Interaction analysis – multiple binding, on page 53. It is also
possible to enhance the specificity by using a secondary binder. For example, if a ligand
binds a family of analyte species, the secondary binder should be able to distinguish
between these different analyte species. In addition, secondary binders are commonly
used in analyses of different types of multicomponent complexes.
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3.7 Methods
Biacore T200 offers three ways of performing analyses. Two of them, Manual run and
Wizards are demonstrated in the previous exercises. The third option is to run methods
that are defined using the Method Builder. A method can be generated from a wizard
template and opened in Method Builder in cases where additional flexibility is needed,
or Biacore Methods with pre-defined example settings can be used and modified if
necessary. Methods may also be built from scratch in the Method Builder. When you
are used to working with the wizards in Biacore T200 Control Software, you can explore
the additional flexibility in the Method Builder by creating your own methods. For
further information on Method Builder, refer to Biacore T200 Software Handbook.

Step Action

1 To create a Method from a wizard template, choose File:Open/New
Method. Tick the option Show importable wizard templates. Open the
Tutorial folder and select the wizard template you created in Exercise 4. Click
on Open.
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Step Action

2 The Wizard Template is now opened in Method Builder and converted to a
method. The details of how Method Builder is used will not be covered here
(see Biacore T200 Software Handbook for further information).
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3.8 Exercise 6. Kinetic analysis
In this exercise, the ligand (monoclonal anti-β2-microglobulin) is immobilized on the
CM5 sensor chip surface. A kinetic analysis is then performed using the Kinetics/
Affinity wizard.

Immobilization of ligand

An immobilization level of 1200 RU will result in an Rmax of approximately 30 RU.

Running buffer: HBS-EP+.

Immobilization buffer: 10 mM Sodium acetate buffer, pH 5.0.

Preparations: Dilute the ligand (monoclonal anti-β2μ-globulin) in immobilization
buffer to 10 μg/ml (4 μl ligand + 396 μl buffer).

Step Action

1 In the Run menu, choose Wizard. Select Immobilization in the Surface
Preparation folder and click on New.

2 In the Immobilization Setup wizard window, select Chip Type: CM5 from
the dropdown menu. Tick the options Immobilize flow cell 2 and Aim for
immobilized level with Target level: 1200 (RU) and Wash solution:
Ethanolamine. Enter the ligand name “anti-beta 2 micro”. Leave all other
flow cells unchecked. Click on Next.
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Step Action

3 In the System Preparations dialog box, uncheck the Prime before run
option. Since the Prime procedure was run in Exercise 1 and the instrument
has not been in standby mode for long, Prime is not necessary here.
Temperature settings should be kept at 25°C. Click on Next.

4 In the Rack positions dialog, click on Eject Rack. Take out the rack tray and
click OK to close the lid. Prepare and place the vials in the appropriate rack
positions. Make sure you have at least the minimum volume required for
each sample. Click on Eject Rack and insert your tray and samples. Click OK
to insert the tray. Click on Next.
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Step Action

5 In the Prepare Run Protocol dialog, click on Start and then enter a file
name for the results, “ImmobilizationExercise7”, and click Save.

Kinetic assay set-up

The unmodified Flow cell 1 will be used as Reference surface (upstream of the active
Flow cell 2).

Running buffer: HBS-EP+.

Regeneration solution: Glycine-HCl, pH 2.5

Preparations: Dilute the β2μ-globulin in running buffer to 32 nM (2.26 μl β2μ- globulin
+ 598 μl buffer). Prepare the concentration series from the 32 nM sample: mix 300 μl of
the 32 nM solution with 300 μl running buffer to get the 16 nM concentration. Continue
the dilution series to obtain the following: 32, 16, 8, 4 and 2 nM. 8 nM should be run in
duplicate, and three zero samples should be included

Step Action

1 In the Biacore T200 Control software, open the the Kinetics/Affinity wizard
by choosing File: Open/New Wizard Template. Select Kinetics/Affinity
and click New.

2 In the Injection Sequence dialog, choose Flow path: 2-1 (Flow cell 2 is the
active and Flow cell 1 is the reference cell) and check that the Chip Type is
CM5 and Regeneration is set to 1. Click on Next.
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Step Action

3 In the Setup dialog, check the Run startup cycles option. Enter Solution:
Buffer and Number of cycles: 3.
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Step Action

4 In the Injection Parameters dialog, enter in the Sample section the
following parameters: Contact time: 120 s, Flow rate: 30 μl/min, Disso-
ciation time: 300 s. In the Regeneration section enter: Solution: Glycin-
HCl, pH 2.5, Contact time: 30 s, Flow rate: 30 μl/min. Stabilization
period: 0 s. Click on Next.

3 Exercises
3.8 Exercise 6. Kinetic analysis

Biacore T200 Getting Started 28980883 AC 67



Step Action

5 In the Samples dialog, enter the name of the analyte, “beta 2 micro”, and
the molecular weight (MW), 11800 D for each of the following concentra-
tions: 0, 2, 4, 8, 16 and 32 nM. Run a duplicate of 8 nM at the end of the
concentration series and after that two zero samples (0 nM i.e buffer). Use
the figure below for further guidance. The run order should be set to As
entered. Click on Next.

6 In the System Preparations dialog, select Prime before run. Normalize
the detector is not necessary and Temperature settings should be 25°C.
Click on Next to continue.
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Step Action

7 In the Rack positions dialog, click on Eject Rack. Take out the rack tray and
click OK to close the lid. Prepare and place the vials in the appropriate rack
positions. Make sure you have at least the minimum volume required for
each sample. Click on Eject Rack and insert your tray and samples. Click OK
to insert the tray. Click Next.

8 In the Prepare Run Protocol dialog, click on Start and then enter a file
name for the results: “date - KineticsExercise6” and click Save.

Evaluation of the results

Step Action

1 Start Biacore T200 Evaluation software: click on the Start menu and select
Biacore T200 Evaluation from the Biacore menu.
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Step Action

2 Choose File: Open, and open your results file from Exercise 7. In the Evalua-
tion Explorer you will see a list of Evaluation items. These are predefined
evaluation items (such as Sensorgram) and different locked quality control
plots (such as Baseline: Sample and Binding to reference). Additional evalua-
tion items will also be listed when a new Sensorgram or Plot is created or
when an analysis is performed.

3 Click on the Kinetics/Affinity button on the toolbar and choose Surface
bound.
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Step Action

4 The Select Curves dialog presents the concentration series available in the
current results set. Choose the curves to be included in the evaluation in the
Include column in the table of curves. By default, all curves for the sample
are included: sensorgrams for non-zero concentrations are shown in color,
and sensorgrams for blanks (zero concentrations) in light gray. Click on
Next.
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Step Action

5 The Select Data dialog shows the blank subtracted curve set, i.e. the
sensorgrams from the zero concentrations have been subtracted to correct
for any systematic disturbances. Here it is possible to delete selected
regions from all or selected curves to eliminate spikes or other disturbances,
for example.

6 Click on Kinetics to initiate the kinetic evaluation.
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Step Action

7 The model 1:1 Binding is selected by default. Click on Fit to perform the
fitting.
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Step Action

8 The Quality Control tab (for evaluations using the predefined 1:1 model
only) gives a brief overview of the reliability of the results.

The symbols used on this tab have the following meanings:

 (Green) Pass: quality assessment acceptable.

 (Yellow) Warning: quality assessment close to the limits of accepta-
bility

 (Red) Fail: quality assessment unacceptable

 (Blue) Neutral or user assessment required

The quality of the fitting is assessed in five areas: Magnitude of kinetic
constants, Parameter uniqueness, Bulk refractive index, Sensorgram curva-
ture and Residuals (more information can be found in Biacore T200 software
handbook). Use the Quality Control assessment as a help in making your
own judgment of the results. Pass status in the quality control parameters
does not necessarily indicate that the fit is acceptable or that the results are
biologically relevant. On the other hand, Fail status in any of the parameters
is a reliable warning indicator. Base your assessment on the overall quality of
the results and the fitting, taking all quality control parameters into account

3 Exercises
3.8 Exercise 6. Kinetic analysis

74  Biacore T200 Getting Started 28980883 AC



Step Action

9 Inspect the report window. The report window displays the fitted parame-
ters (ka, kd, RI, Rmax, tc) or calculated (KD, kt) parameters. A parameter is
either local (the parameter is different for every curve) or global (the same
parameter value is valid for all curves). Inspect the values in the table. The
calculated numbers should be biologically and experimentally relevant.

The U-value is an estimate of the uniqueness of the calculated values for rate
constants and Rmax. If parameters are correlated, the fitting procedure can
determine their relative magnitudes but not absolute values. The U-value is
reported as a single value for the whole fitting. U-values above about 25 indi-
cate that absolute values for two or more of the parameters (rate constants
and Rmax) are correlated and cannot be determined. If the U-value is below
about 15 the parameter values are not significantly correlated.

10 Inspect the sensorgrams. The black curves superimposed on top of the
sensorgrams represent the calculated curves.
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Step Action

11 Switch to the residual plot window by clicking on the Residuals tab. The
residual plot shows the difference in RU between each data point for the
experimental curves and the calculated curves. The shape and distribution
of the residuals indicate how well the data fit to the chosen model. As an aid
in judging the residuals, guidelines are drawn on the residual plot to indicate
the range of acceptability. Most of the residuals should be within the inner
(green) limits

12 Click on Finish to complete the evaluation and place the item in the evalua-
tion explorer panel.
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4 Biacore T200 routine maintenance

Regular maintenance of Biacore T200 is of the utmost importance for reliable results. It
is important to avoid contamination, such as microbial growth and adsorbed proteins
in the liquid handling system.

In Biacore T200 Control Software, maintenance procedures can be found under Tools:
More Tools. In the BIAmaintenance Kit Type 2 (BR-1006-51) you will find the solutions
required to run the different procedures. Use the Maintenance Chip when running
methods Desorb, Desorb and Sanitize and Wash Buffer Tubing. Inspect both sides
of the chip before use. If necessary, clean the surface with water and wipe it dry.

The local field service representative provides preventive maintenance service every 6
or 12 months. Biacore personnel will be happy to discuss the service frequency most
suitable to your situation.

Daily maintenance

• Prepare fresh buffers.

• Change to fresh water and check that the waste bottle is not full.

• Flush the system by choosing Tools: Prime.

• Between experiments, maintain a continuous buffer flow by selecting Tools:
Standby.

• If you intend to leave the instrument for more than four days, shut down the instru-
ment by choosing Tools: Shutdown.

Weekly maintenance

• Run Desorb from the menu Tools: More Tools to clean the liquid system

• Inspect tube fittings and pumps to check for leaks and salt deposits. If you find leaks
at tube fittings, clean with water and tighten the connections. If you find leaks in
either of the syringe pumps, call your Biacore service representative.

Monthly maintenance

• Run Desorb and Sanitize from the menu Tools: More Tools to remove any
adsorbed material in the liquid system and disinfect the system.

• Run System Check from the menu Tools: More Tools, according to the instruc-
tions in the wizard.

• Clean the instrument cover.

• Inspect the sample compartment and remove spillage with water or ethanol if
required.

4 Biacore T200 routine maintenance
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When necessary

• Run Wash Buffer Tubing to clean buffer tubing and remove adsorbed material (e.g.
detergent).

• Run Empty Buffer Tubing (by selecting Tools: More Tools) to clean and empty all
buffer tubing after using several buffers, and when buffer tubing will not be used.

4 Biacore T200 routine maintenance

78  Biacore T200 Getting Started 28980883 AC



Page intentionally left blank



cytiva.com/biacore

Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate.

Biacore is a trademark of Global Life Sciences Solutions USA LLC or an affiliate doing business as Cytiva.

All other third-party trademarks are the property of their respective owners.

© 2020 Cytiva

All goods and services are sold subject to the terms and conditions of sale of the supplying company operating within the Cytiva
business. A copy of those terms and conditions is available on request. Contact your local Cytiva representative for the most current
information.

For local office contact information, visit cytiva.com/contact

28980883 AC V:4 12/2020

http://cytiva.com/biacore
http://cytiva.com/contact

	Table of Contents
	1 Biacore T200 Getting Started
	Introduction
	Requirements
	References
	Contents of the Getting Started Kit
	Ordering information


	2 Background information
	2.1 Biacore terminology
	2.2 Sensor surface properties
	2.3 Immobilization
	Amine coupling
	Conditions for immobilization
	Example of immobilization pH-scouting
	Immobilization levels
	Ligand requirements

	2.4 Interaction analysis
	Sample requirements

	2.5 Regeneration
	Testing regeneration conditions
	Choice of regeneration conditions


	3 Exercises
	3.1 Description of the experimental set-up
	3.2 Exercise 1. Start up
	Start the system
	Insert a sensor chip and prime with buffer
	Removing a sensor chip
	Rack trays and racks
	Ejecting and removing the rack tray or Sample and Reagent Rack
	Normalizing the signal response

	3.3 Exercise 2. Effect of buffer on pre-concentration
	Conclusion

	3.4 Exercise 3. Immobilization
	Set up a template for immobilization
	Immobilization results

	3.5 Exercise 4. Interaction analysis
	Interaction analysis results
	Evaluation of the results
	Conclusions

	3.6 Exercise 5. Interaction analysis – multiple binding
	Multiple binding results
	Conclusions

	3.7 Methods
	3.8 Exercise 6. Kinetic analysis
	Immobilization of ligand
	Kinetic assay set-up
	Evaluation of the results


	4 Biacore T200 routine maintenance
	Daily maintenance
	Weekly maintenance
	Monthly maintenance
	When necessary

	Document information

